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1. INTRODUCTION

About this document
When using the PDF viewer from Adobe, Acrobat Reader, this document is best viewed in
1024x768 (or higher) resolution. We realize that not everyone has access to hardware capable of
such resolutions and apologize if the document appears hard to read on some displays.

The bookmarks window (typically displayed to the left of the document window) can be closed to
gain some display space for the document window. Furthermore, the View options Fit page and Fit
width can be used to change the display of the document. We also recommend experimentation with
the various display settings in the reader, in particular the Smooth text and monochrome images
option (located under File.Preferences.General in the English language version of the reader).

One, perhaps not so obvious, feature in the Acrobat Reader is the ability to jump "back" after having
followed a link. To jump back, hold down the CTRL  key and press - (minus).

Legal notice
The FrontDoor Activity Monitor, "FDAMON" hereafter, is provided to you "as is", without
warranties of any kind. In no event shall Definite Solutions HB be liable to you or anyone else for
any damages or costs arising from the use or inability to use this program.

FDAMON is protected by international copyright laws and treaty provisions, and may not be
modified, reversed engineered, sold or distributed in any way that would involve some sort of trade,
without written permission from Definite Solutions HB.

FDAMON may be used without charge by anyone that is running a registered copy of the shareware
version of FrontDoor, or the commercial version of FrontDoor.

FDAMON may also be used during the 30-day trial/evaluation period of the shareware version of
FrontDoor. After this period, FrontDoor must be registered if you want to continue using this
program (or FrontDoor).

Version notation
The following notations are used to indicate where features are supported differently by various
versions of the FrontDoor mailer:

[ML] Multi-line version
[SL] Single-line version (Shareware)

Using this document
This document is intended to be used as a reference guide. It makes the assumption that the reader
understands the basics of the FrontDoor mailer; "FD" hereafter. The document does not attempt to
explain any configuration issues in detail. For this purpose, the reader is advised to refer to the
FrontDoor Administrator Guide.

http://www.adobe.com/


FrontDoor Activity Monitor User Guide

Introduction Page 6

What this program does
The FrontDoor Activity Monitor for Windows (FDAMON) is a tool that provides for the monitoring
of one or more FD tasks through the FrontDoor Activity Database interface, introduced in version
2.30.mL of FD.

Currently, FDAMON features only one-way communication in that it can only "look but not touch";
i.e. it cannot be used to affect the behavior of FD.

FDAMON will prove particularly useful in environments where the FD tasks are not located in the
same physical location as the person or persons responsible for administrating the FrontDoor
system.

System requirements
FDAMON does not require any special components to be installed on your system. The program
has been tested under Windows 3.x and Windows for Workgroups 3.x, Windows 9x, Windows
NT 4.x, and WinOS2 (Windows under OS/2) with good results.

Installation
Copy the files contained in the distribution archive or on the distribution media into any directory on
your system; it is recommended, but not required, that the various FDAMON related files are kept
in a separate directory.

The FDAMON configuration file, FDAMON.INI, is by default maintained in the Windows directory.
The location used for the configuration file can, however, be specified on the command-line (see
below).

� If you were using a previous version of FDAMON, it is possible that its configuration file, FDAMON.INI, was
named AMON.INI; simply rename AMON.INI to FDAMON.INI before running this version of FDAMON for
the first time.

First-time usage
FDAMON is started from the Windows desktop. When used with Windows 9x or Windows NT, it
can also be started from the command-prompt (i.e. in a "DOS box").

When FDAMON is started for the first time, it will display an empty working area with the text No
profile  in its titlebar.

The current time is displayed in the lower right-hand corner; to the right of the time is a small
asterisk (*), indicating that FDAMON is unable to access the FrontDoor Activity Database. For
first-time use of FDAMON, this is not an error condition. If, however, FDAMON should continue
displaying the asterisk to the right of the current time, it is an indication that all is not well. The file
that FDAMON is looking for in the Database path is named ACTMONDB.FD (see "Configuration").
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2. CONFIGURATION
Although FDAMON requires very few options to be configured, it needs to know a few details
about the system on which it is to be used. In particular, it needs to know where to look for the
FrontDoor Activity Database (stored in the ACTMONDB.FD file in the FrontDoor SYSTEM
directory).

To access the program configuration, select Properties from the File menu.

The properties dialog will be displayed. It contains a number of property pages; they are described
in detail below.

General
This page contains one option (Database path) that must be configured for the program to function
properly.

Database path
Specifies the drive and directory where FDAMON can expect to find the FrontDoor Activity
Database file, ACTMONDB.FD.

To change this configuration option, a complete path (e.g. C:\FD\) can be specified by entering it
into the field; alternatively, the database path can be specified by first clearing the contents of the
field and then pressing the browse button (…) to the right of the field.

FDAMON will not allow you to specify a directory in which it cannot find the ACTMONDB.FD file.

� The program requires that directory names be entered with a trailing backslash (\); e.g. if the
ACTMONDB.FD file is located in C:\FD, it should be entered as C:\FD\ in this field.

Default profile
Specifies the name and location of the default profile (.MPR) file. If this configuration option has
been specified, FDAMON will attempt to open the specified profile when starting. FDAMON
profiles have the extension .MPR (Monitor PRofile). See "Working with profiles" in the "Program
usage" section for more information about profiles.

Window settings
This page contains options that affects the general appearance and behavior of FDAMON. It should
be noted that some of these settings can also be configured in a profile (see "Working with profiles"
in the "Program usage" section) to override the global program settings.

Restore program's window position
Specifies that FDAMON should attempt to restore the position of its main window when it is
started.
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Restore program's window size
Specifies that FDAMON should attempt to restore the size of its main window when it is started.

Hide tool bar
Specifies that the tool bar, normally displayed just below the main menu, should be hidden. Hiding
the tool bar will make more room available in the working area of the program.

Hide status bar
Specifies that the status bar, normally displayed at the bottom of the main window, should be
hidden. Hiding the status bar will make more room available in the working area of the program.

All monitors
This page contains options that affect the creation of new monitors; i.e. monitors created manually
from within the program.

Create new monitors minimized
Specifies that newly created monitors should by default be minimized to the bottom of the main
window's working area.

� This setting does not apply to Traffic light  monitors; such monitors cannot be minimized.

Monitor type
Specifies the default type for new monitors. It is recommended that this setting be configured to the
most commonly used monitor type.

Standard
This page contains options that affect new Standard monitors created manually from within the
program.

Simple
This page contains options that affect new Simple monitors created manually from within the
program.

� There are currently no default settings for Simple monitors.

Traffic light
This page contains options that affect new Traffic light  monitors created manually from within the
program.
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� There are currently no default settings for Traffic light  monitors.

History
This page contains options that affect new History  monitors created manually from within the
program.

Default history path
Specifies the default path for files with the .HIS extension; i.e. FrontDoor Mail History files. This
should typically be configured to the same path as the Database path (above).

� FDAMON will not allow you to specify a directory in which it cannot find one or more files with the .HIS
extension.
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3. PROGRAM USAGE
FDAMON is started from the Windows desktop. When used with Windows 9x or Windows NT, it
can also be started from the command-prompt (i.e. in a "DOS box").

Initial display
When FDAMON is started for the first time, or when no default profile has been configured (see
"Default profile"), it will display an empty working area with the text No profile in its titlebar.

Unless the status bar has been configured as hidden, the current time is displayed in the lower right-
hand corner. If a small asterisk (*) is also displayed, to the right of the current time, it is an
indication that FDAMON is unable to access the FrontDoor Activity Database. Please see
Configuration (above) for more information about configuring FDAMON.

Creating a new monitor
To create a new monitor, select New from the Task menu; alternatively, the New Task shortcut,
CTRL+N , can be used.

FDAMON will display the New Task Monitor dialog where you must specify a task number to
monitor and what type of monitor it should create for that task. The monitor type setting will take
the value configured as the default monitor type (see "Configuration").

When the required data has been specified, click the OK  button to create the new monitor; click the
CANCEL  button to exit the dialog without creating a new monitor.

FDAMON will only allow one monitor per task.

Creating a new history monitor
To create a new history monitor, move the selection bar to History monitors on the Task menu;
there is no shortcut to create a new history monitor. When the selection bar is positioned on the
History monitors option, a sub-menu with two options will be displayed; one creates an inbound
history monitor, the other creates an outbound history monitor.

� Only two history monitors can exist at any given time.

Working with profiles
A profile is a collection of settings that allow FDAMON to be quickly configured according to a
particular layout. Profiles are stored in files with the .MPR extension (Monitor PRofile).

A profile can be created any time, provided one or more monitors exist.

The current profile is displayed in the program's titlebar; if no profile is currently in use, the text No
profile  is displayed.

To save the current layout to a profile, select Save As… from the File menu. If a profile is already in
use, the Save function in the File menu can be used to save the current layout to that profile. The
shortcut for the Save function is CTRL+S.
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The Open function in the File menu can be used to instruct FDAMON to reconfigure the layout
according to an existing profile.

Global overrides
The two configuration options "Hide tool bar" and "Hide status bar" (see "Configuration") will be
ignored whenever a profile is loaded; i.e. the setting of these two options will be taken from the
profile rather than the global program configuration data stored in FDAMON.INI.

When a profile is saved (see above), FDAMON will write the current state of these two options to
the profile along with information about the current monitor layout.

Two additional settings that cannot be globally configured are also written to a profile. These
control whether or not the main menu and program border (titlebar) should be displayed. As with
the two options mentioned above, the current state of these options will be saved to the profile. See
"The work area pop-up menu" for more information about these settings..

Working with monitors
All monitors have two controls in common: the pop-up menu and the window menu. Naturally, all
monitors behave like windows do in general; i.e. they can be moved around the work area of
FDAMON, etc.

The pop-up menu
The contents of the pop-up menu vary depending on the monitor type, but the method by which the
pop-up menu is displayed remains the same.

To display the pop-up menu for a monitor, position the mouse pointer somewhere on the monitor
and click the RIGHT  mouse button.

The various functions available from the monitor pop-up menu will now be described; it should be
noted that the keyboard shortcuts listed below apply to the active monitor (the one with input focus).

Enabled
Displays the current state of the monitor. A monitor can be temporarily disabled without having to
remove or hide it. When a monitor has been disabled, it will not be updated until it is re-enabled.
Disabled monitors have a red light in their upper left-hand corner.

The shortcut for this function is CTRL+E .

Verbose
Determines the size of Standard monitors. Since these monitors typically contain fixed-size
information, they occupy a lot of space if the display is set to verbose.

The shortcut for this function, for Standard monitors, is INS (Insert).

Session
Like verbose (above), this function also determines the size of Standard monitors. When Session is
disabled, the size of a Standard monitor is somewhere near half its full size.
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There is no shortcut for this function.

Clear
Clears the scrolling message display section for Standard and Simple monitors.

The shortcut for this function, for Standard and Simple monitors, is DEL  (Delete).

Default size
Resizes a History  monitor to its default size.

There is no shortcut for this function.

Lines
Toggles the display of horizontal grid lines for History  monitors.

The shortcut for this function, for History  monitors, is INS (Insert).

Stretch horizontal
Stretches the display horizontally of Simple and History  monitors. The size of the monitor is
horizontally enlarged until its right edge is as close as possible to the right edge of the work area of
the main window.

There is no shortcut for this function.

Stretch vertical
Stretches the display vertically of Simple and History  monitors. The size of the monitor is
vertically enlarged until its bottom edge is as close as possible to the bottom edge of the work area
of the main window (the status bar, if displayed, will be taken into account).

There is no shortcut for this function.

Copy
Copies the currently selected text in the scrolling message display section of the monitor to the
clipboard (for all but Traffic light  monitors). To paste the copied text into another application, the
Paste function in the Edit menu is typically used (or the CTRL+V  shortcut).

The shortcut for this function, for all but Traffic light  monitors, is CTRL+C .

Select all
Selects all text in the scrolling message display section of Standard, Simple, and History  monitors
to the clipboard. Use the Copy function, described above, to copy the selected text to the clipboard.
See "Monitor-specific notes" for more information about selecting text from the scrolling message
display.

The shortcut for this function, for Standard, Simple, and History  monitors, is CTRL+A .
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Information
Displays information about the program that generated the last activity entry for the task being
monitored by the monitor.

There is no shortcut for this function.

The window menu
The available options in the window menu vary depending on the monitor type, but the method by
which the window menu is displayed remains the same.

To display the window menu for a monitor, position the mouse pointer in the upper left-hand corner
of the monitor and click the LEFT  mouse button.

The various options in the monitor window menu will now be described.

Restore
Restores a minimized monitor to the size and position of the monitor prior to being minimized.

There is no shortcut for this function.

Move
Allows moving of a monitor.

There is no shortcut for this function.

Size
Allows resizing of a monitor.

There is no shortcut for this function.

Minimize
Minimizes the monitor to the bottom of the work area of the main window.

There is no shortcut for this function.

Maximize
Maximizes the monitor, if applicable, display to cover the entire work area of the main window.

There is no shortcut for this function.

Close
Closes the monitor. To close all monitors, select Close All from the Task menu.

The shortcut for this function is CTRL+F4 .

Next
Changes the current input focus to the next monitor (if any).
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The shortcut for this function is CTRL+F6 .

Controlling the work area layout
Although all monitors have a separate window menu and window controls that can be used to
control the layout of the monitor, the most convenient method to control the layout of the work area
is by using the functions available in the Window menu.

The various functions in the Window menu will now be described.

Tile vertically
Arranges all non-minimized monitors; priority is given to vertical size and position. Minimized
monitors are aligned towards the bottom of the work area of the main window, but not otherwise
affected.

There is no shortcut for this function.

Tile horizontally
Arranges all non-minimized monitors; priority is given to horizontal size and position. Minimized
monitors are aligned towards the bottom of the work area of the main window, but not otherwise
affected.

There is no shortcut for this function.

Cascade
Arranges all non-minimized monitors in a "stacked" fashion. Minimized monitors are aligned
towards the bottom of the work area of the main window, but not otherwise affected.

There is no shortcut for this function.

Arrange All
Arranges all minimized monitors to be aligned towards the bottom of the work area of the main
window. Non-minimized monitors are not affected.

There is no shortcut for this function.

Minimize all
Minimizes all non-minimized windows.

There is no shortcut for this function.

Restore minimized
Restores all minimized windows to their original size and position.

There is no shortcut for this function.
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The work area pop-up menu
As with monitors, the work area has its own pop-up menu. The work area pop-up menu is
particularly useful when the border (titlebar) and/or menu of the main window is hidden.

To display the work area pop-up menu, position the mouse pointer somewhere on the work area (not
on a monitor) and click the RIGHT  mouse button.

The various functions available from the monitor pop-up menu will now be described.

Hide titlebar
Hides the border (titlebar) of the main window. It should be noted that the main window cannot be
resized or moved when the border is hidden.

There is no shortcut for this function.

Hide tool bar
Hides the tool bar (which contains various speed buttons) of the main window.

There is no shortcut for this function.

Hide status bar
Hides the status bar of the main window.

There is no shortcut for this function.

Hide menu
Hides the (main) menu of the main window.

There is no shortcut for this function.

Save
Saves the current layout to the current profile.

The shortcut for this function is CTRL+S.

Save as…
Saves the current layout to a profile.

There is no shortcut for this function.

Exit program
Exits FDAMON.
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Monitor-specific notes
The text in the scrolling message display section of the Simple, Standard, and History  monitors
can be selected and then copied to the clipboard for further use.

Standard monitor information
The session information displayed in the lower half of the Standard monitor window shows the
current session, or the last session if no session is currently in progress. It should be noted that the
time displayed after Inbound/Outbound (immediately above Inbound statistics) is the starting
time of the session.

Selecting text
Selecting text in the Simple and Standard monitors works like text selection normally does in
Windows applications.

The History  monitor works slightly different when selecting text and navigating between the entries
in general; specifically in regards to how keyboard commands are handled. For the remainder of this
section, "the monitor" refers to a History -type monitor.

Each time the monitor is repainted (updated), it will clear the current selection and then select the
last row in the history list. The current column is set to the rightmost column.

When the UP, DOWN, LEFT , and RIGHT  keys are used, they move the currently selected cell;
i.e. the cell with focus. If the SHIFT  key is held down, cells will be selected from the point where
the SHIFT  key was first held down to the current point.

The PGUP and PGDN keys behave much like the UP and DOWN keys; the primary difference is
that instead of moving the current cell by one, they move the current cell by an entire page.

The HOME  and END keys move the current cell to the leftmost and rightmost cell respectively. To
select an entire row quickly, simply press the HOME  key, hold down the SHIFT  key and press
END.

If the UP, DOWN, LEFT , and RIGHT  keys are used while the CTRL  key is held down. The
history list display is shifted in the direction of the cursor key. The current cell is not, however,
changed.

To go to the first cell in the history list, press CTRL+HOME .

To go to the last cell in the history list, press CTRL+END .
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Appendix A:  CONTACT INFORMATION
Definite Solutions can be reached at:

Postal address: Definite Solutions HB
Förskottsvägen 11
S-12932  Hägersten
SWEDEN

Telephone: +46 8 6456495 (0800-1800 CET, Mon-Fri )

Fax: +46 8 55630102

BBS: +46 8 55630102 (V.34 8N1, X.75 ISDN)
+46 8 55630103 (V.34 8N1, X.75 ISDN)

FidoNet: 2:201/329
2:201/330

Internet: sales@defsol.se
http://www.defsol.se/

Please refer to our website (above) for additional information such as the FrontDoor Developer’s Kit
(FDDEV), the FrontDoor Frequently Asked Questions (FDFAQ) document, and more.

mailto:sales@defsol.se
http://www.defsol.se/
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